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About this guide
The User Guide provides instructions for performing common, daily tasks  in LexisNexis Time Matters® and 
Billing Matters® Practice Management Software. If you need additional information, please refer to the online  
Support Center.
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Getting Started

Log in
 1.  Start Time Matters using one of the following methods:

 n Double-click the Time Matters 13.0 icon on your desktop.

 n On the Windows Start menu, click All Programs, then click LexisNexis, and then click Time 
Matters 13.0.

The Welcome screen opens.

Note

If Time Matters opens without displaying the Welcome screen, the login information of the previous 
user was saved.

 2.  Enter your Time Matters user ID and password.

 3.  Optionally, click the Options button to show additional options on the Welcome screen. 

Screen 
element

Description

Staff

Select the Staff you want to use in this session. The selected Staff's records will appear 
by default on the Calendar and "My [record type]" lists.

If a default Staff is assigned to your user ID, you do not need to select a Staff here 
unless you want to change the Staff whose records appear by default on the Calendar.

Date
The current date. By default, this date is entered on new records and  displayed on the 
Calendar. Normally, there is no reason to specify a different date than the current date.

Save This 
Login

Saves your user ID and password and uses them automatically the next time you start 
Time Matters. If a different user needs to log in, click the File menu and then click Re-
Login to display the login window.

Time Matters for Microsoft Outlook will use your saved login by default.

This check box is automatically cleared if the Require Program Login Screen option 
is selected in Workstation Level Setup.

Show 
Reminders

Opens the Alerts and Reminders window after you log in.

 4.  Click OK.
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Start the application in Training Mode
Training Mode provides sample data that you can use to practice using Time Matters features. This data is 
separate from your working database, so you can make any changes you like without affecting real data.

Warning

It is advisable not to enter real data while in Training Mode, unless you have also changed the default user 
ID and password and set up security features to prevent unauthorized users from using Training Mode to view 
real data.

 1.  Start Time Matters using one of the following methods:

 n Double-click the Training Mode - Time Matters 13.0 icon on your desktop.

 n On the Windows Start menu, click All Programs, then click LexisNexis, and then 
click Training Mode - Time Matters 13.0.

 2.  On the Welcome screen, enter TM as the user ID and TM as the password.

 3.  Click OK.
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Change your password
Security settings might require you to change your password the next time you log in, by a particular date, or 
on a recurring basis.

If you need to change your password, a window will open to ask for the new password.

 1.  Enter your old password and new password in the corresponding boxes. Type your new password a 
second time in the Confirm Password box.

 2.  On the Next Login Password Change window, click OK.

-or-

On the Password Expiration window, click Change.
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Change your password when not required
If security settings allow you access to the User Form, you can change your password at any time.

 1.  Select File > Setup > User and Security > Users.

The Security Setup - List of Users window opens.

 2.  Double-click your user ID on the Security Setup - List of Users window that opens.

The Security Setup - User Form window opens.

 3.  In the Password box, type your new password.

 4.  In the  Confirm box re-type your new password.

 5.  Click OK.
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Use the Navigator to open program features
Use the Navigator window to access many application features from one location.

Each tab along the left side of the window provides buttons for a collection of related tasks.

Do one of the following to display the Navigator window:

 n On the View menu, click Navigator

 n Press CTRL+N
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View a list of records
Each record type (such as Contacts, Matters, and Documents) has a main record list. The list is often the 
most convenient place to locate specific records and view summary information about them.

Although most types of record lists can be accessed from the Database menu, others are accessed from 
other menus.

To view a list of...

 n Contacts: Click the Database menu, point to Contact List, and click All Contacts.

 n Matters: Click the Database menu, point to Matter List, and click All Matters.

 n Events: Click the Calendar menu, point to Event List, and click All Events.

 n ToDo’s: Click the Calendar menu, point to ToDo List, and click All ToDo’s.

 n Documents: Click the Database menu, point to Document List, and click All Documents.

 n Notes: Click the Database menu, point to Note List, and click All Notes.

 n Email: Click the Mail menu, point to Email List, and click All Email.

 n Mail: Click the Mail menu, point to Mail List, and click All Mail.

 n Phone Calls: Click the Database menu, point to Phone Call List, and click All Phone Calls.

 n Billing Items: Click the Billing menu, point to Billing Item List, and click All Billing Items.

 n Custom Forms: Click the Database menu, point to Custom Form List, and click All Custom Forms.

 n Lexis Research Records: Click the Database menu, point to Lexis Research, and click All Lexis 
Research.

 n Outlines: Click the Database menu, point to Outline List, and click All Outlines.

 n User Defined Records: Click the Database menu, point to <user defined name> List, and click All 
<user defined name>Types.
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Locate a record on a list
Time Matters provides several ways to locate a specific entry on a record list. Two simple methods are 
using QuickPik and the Search box on the list toolbar.

To use QuickPik:
 1.  Click the header of the column you want to search on.

 2.  Type the first few characters of the word or number you want to find.

The record that most closely matches what you are typing will be highlighted in the list.

To use the Search box:
 1.  Click inside the Search box on the list toolbar.

 2.  Type a word, name, or number associated with the record you want to find.

 3.  Press ENTER.

The list will be filtered to display only records that match the text you typed.
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Open a record for viewing or editing
 1.  Open the list of the record type you want to view.

 2.  Double-click the record you want to view or edit.

The record form opens.

 3.  Click the tab corresponding to the type of information you want to view or edit.
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New features

Client Portal online document sharing
A new, integrated client portal, powered by technology from WatchDox™, lets you share your Time Matters 
documents online with clients, experts, and other third parties. This file-sharing portal helps you control and 
protect your shared files by allowing you to:

 n Define who can access the file—only the contact(s) associated with the matter, anyone with the same email 
domain as the contact(s) or everyone

 n Determine what they can do with the document—view, print or download

 n Prevent screen captures of the file by displaying only small areas at a time

 n Identify the timeframe that they can access the document

 n Track the file’s whereabouts at all times and maintain an audit trail for compliance purposes

 n Revoke access to files anytime

Contacts are notified of shared files by email and can view the files from any Internet-connected computer, 
smartphone, or tablet. Please see the "Document sharing" section of this guide, and your Time Matters Help or 
Online Help for more details on sharing files with your clients.

Automatic data backup
Time Matters 13 lets you schedule and automate backups of your Time Matters database and Time Matters 
shared file directory to help protect you from the unexpected. You can specify a time of day for the backup that’s 
convenient for firm members, and the backup frequency. You can also perform a manual backup at any time. 
For more information on automating backups please see "Backup Time Matters Data" in the Administration 
Guide or in this Time Matters Help or Online Help.
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Sort records by column headers
A new sort feature has been added to the Contact Timeline, Matter Timeline, and the Attachments List that 
allows you to sort records by the column headers, in ascending or descending order. By using this sort feature, 
the information you are looking for can be more readily accessible. Below are example sorts from the 
Attachments List. The first is an example of the records sorted by Date, the second is an example of those same 
records sorted by Time.

 

To sort the records, simply click on the column header of the column you wish to sort by. You can toggle 
between ascending and descending order by clicking on the header again.
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Color-code matters in the calendar
There is a new feature in the calendar that lets you color code matters  to easily identify related tasks and 
events, as well as visually remind you about the billable time you’ve worked throughout the day.

Before you can select colors for matters, you need to change the “Header Color” in the Calendar Display Options 
window. When that is done, then you can open each matter you want to color code, and select the color for that 
matter. Once a color is selected the color is displayed on all events and todo's associated with that matter. The 
color is also applied to all staff members who are selected to show on the calendar.

Set the Header Color option for matters
To set the header color option for matters:

 1.  Click the Calendars button on the toolbar, to open the Calendar window.

 2.  Select Edit > Display Options from the menu bar.

The Calendar Display Options window opens.
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 3.  Click the Daily/Multi-Day tab, if not already selected.

 4.  Click the Header Color arrow, and select Matter.

 5.  Click OK.

You are now ready to color code as many matters as you want.
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Color code a matter
To color code a matter:

 1.  Click the Matters button on the toolbar, to open the Matters window.

 2.  Double-click on the matter you want to color code.

The Matter Form – Change window opens.
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 3.  Click the Select Color button on the toolbar to display the Select Matter Color pallet.

 4.  Click on the color you want to use, or create a custom color using the Define Custom Colors>> button.

 5.  Click OK to select the color and close the Select Matter Color pallet.

You are returned to the Matter Form – Change window.

 6.  Click the Save & Close button on the toolbar to close the matter.

Now, all events and todo's that are associated with the matter (via the regarding line) display the same 
color. The color is also applied to all staff members who are selected to show on the calendar.

 7.  Repeat steps 2 through 6 for each matter you want to color code.
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Clients and Matters

View a Contact
 1.  Do one of the following to open the Contact list:

 n Click the Contacts button on the main toolbar.

 n Click the Database menu, point to Contact List, and then click All Contacts.

 n Press F5.

 2.  Highlight the Contact you want to view.

Summary information about the Contact appears in the Power View area of the list.

 3.  To open the full Contact record, double-click the Contact in the list.
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Add a Contact
You can add a Contact using the New Contact Intake wizard or using the Contact form.

Add a Contact using the New Contact Intake wizard
 1.  Do one of the following:

 n Press Ctrl+Shift+C.

 n On the File menu, point to New Record and click Contact.

 n On the Contacts list, click the Add button.

The New Contact Intake Wizard opens.

Note

If the wizard is disabled, the Contact form will open instead. 

 2.  Select Person if the Contact is an individual person, or select Organization if the Contact is a group, 
organization, business, etc.

This selection determines which options appear on the second page of the wizard.

LexisNexis® Time Matters® and Billing Matters® User Guide

Company Confidential.   Copyright © 2013 LexisNexis. All rights reserved. 23 of 102



 3.  In the Code box, click the arrow and select the classification code that best describes what kind of 
Contact you are creating.

 4.  On each page of the wizard, enter the information you have about the Contact and click Next.

Tip

You can jump to a specific page of the wizard by clicking the name of the page in the "outline" 
navigation on the left side.

 5.  On the last page of the wizard, click Finish.

 

Add a Contact using the Contact form
 1.  If the New Contact Intake wizard is enabled, disable it:

 a.  On the File menu, point to Setup, then point to General, and then click User Level.

 b.  On the General tab of the User Level Setup window, clear the Contact check box in the Wizard 
Defaults area.

 c.  Click OK.

 2.  Do one of the following:

 n Press Ctrl+Shift+C.

 n On the File menu, point to New Record and click Contact.

 n On the Contacts list, click the Add button.

The Contact form opens.

 3.  If the Contact is an organization rather than an individual, click the Full Name button. The label 
changes to Org Name.

 4.  Enter the Contact's name in the Full Name/Org Name box.

 5.  In the Code box, click the arrow and select the classification code that best describes what kind of 
Contact you are creating.

 6.  If the Contact is a client, enter the number in the ClientNo box. 

 7.  In the remaining areas of the Primary, Secondary, and Additional tabs, enter other information about 
the Contact. 

 8.  Click the Save & Close button.
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Add a Contact related to a specific Matter
 1.  Open the Matter list.

 2.  Select a Matter for which you want to add Contacts.

Do one of the following:

 n Press Ctrl+Shift+C.

 n On the File menu, point to New Record and click Contact.

 n Click the Create New button in the Task Panel on the left side of the Matter list. On the Add New 
Related Record window, select Contact and click OK.

The selected Matter is related to the Contact automatically, and appears in the MatterRef and 
MatterNo boxes.

 3.  Complete the rest of the New Contact Intake wizard, or complete the Contact form and click Save & 
Close.
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View a Matter
 1.  Do one of the following to open the Matter list:

 n Click the Matters button on the main toolbar.

 n Click the Database menu, point to Matter List, and then click All Matters.

 n Press F6.

 2.  Highlight the Matter you want to view.

Summary information about the Matter appears in the Power View area of the list.

 3.  To open the full Matter record, double-click the Matter in the list.
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Add a Matter
You can add a Matter using the New Matter Intake wizard or using the Matter form.

Add a Matter using the New Matter Intake wizard
 1.  Do one of the following:

 n Press Ctrl+Shift+A.

 n On the File menu, point to New Record and click Matter.

 n On the Matter list, click the Add button.

The New Matter Intake Wizard opens.

Note

If the wizard is disabled, the Matter form will open instead. 

 2.  Select Person if the Contact is an individual person, or select Organization if the Contact is a group, 
organization, business, etc.

This selection determines which options appear on the second page of the wizard.

 3.  In the MatterRef box, type a name for the Matter.
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 4.  In the MatterNo box, type a number for the Matter.

 5.  In the Code box, click the arrow and select the classification code that best describes what kind of Matter 
you are creating.

 6.  On each page of the wizard, enter the information you have about the Matter and click Next.

Tip

You can jump to a specific page of the wizard by clicking the name of the page in the "outline" 
navigation on the left side.

 7.  On the last page of the wizard, click Finish.

 

Add a Matter using the Matter form
 1.  If the New Matter Intake wizard is enabled, disable it:

 a.  On the File menu, point to Setup, then point to General, and then click User Level.

 b.  On the General tab of the User Level Setup window, clear the Matter check box in the Wizard 
Defaults area.

 c.  Click OK.

 2.  Do one of the following:

 n Press Ctrl+Shift+A.

 n On the File menu, point to New Record and click Contact.

 n On the Matter list, click the Add button.

The Matter form opens.

 3.  In the MatterRef box, type a name for the Matter.

 4.  In the MatterNo box, type a number for the Matter.

 5.  In the Code box, click the arrow and select the classification code that best describes what kind of Matter 
you are creating.

 6.  In the remaining areas of the Primary, Secondary, and Additional tabs, enter other information about 
the Matter. 

 7.  Click the Save & Close button.
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Associate a Contact with a Matter
When two records are associated with each other, they are referred to as related records. 

You can relate a Contact to a Matter by opening the Contact record and entering the name of the Matter in the 
MatterRef box, or the Matter number in the MatterNo box.

You can relate a Matter to a Contact by opening the Matter record and entering the Contact in any box that 
accepts a Contact. (If the Contact you are relating is the client for whom the Matter was created, enter that 
Contact in the Client box.)

Other kinds of records can also be related to each other. The most common way to relate records is to assign 
them to the same Client and/or Matter. On the record form, enter the Client and/or Matter in one of the boxes 
on the Regarding line. (When you click a Regarding line box, the label "Regarding" changes to indicate the box 
you have selected: either MatterRef, MatterNo, Client, or ClientNo.)
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Calendar

View the calendar
In Time Matters, the calendar is shared among all Staff. You can filter the calendar to show only items assigned 
to you, or you can view items assigned to other Staff (if security settings give you rights to view those items).

There are three calendar views: daily, weekly, and monthly. The daily view has additional options to show 
multiple days at a time.

 1.  Do one of the following to open the calendar:

 n Click the Daily, Weekly, or Monthly button on the main toolbar.

 n Click the Calendar menu and then click the calendar view you want to open: Daily Calendar, 
Weekly Calendar, or Monthly Calendar.

 2.  To view a date other than the current day, do one of the following:

 n Enter the date in the GoTo box on the calendar toolbar.

 n Click the date on the Reference Calendar.

 3.  To view records for a Staff other than yourself, do one of the following:

 n Click the arrow beside the Staff box and select the Staff you want to view.

 n Click the lookup button beside the Staff box and select multiple Staff to view.

 n In the Staff selector area, select the check box beside each Staff you want to view.
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Events and ToDo's
Events and ToDo's are similar, but have important differences:

An Event has both a date and a time. Event records are like appointments. They typically represent meetings, 
hearings, trials, and otehr events that occur at a particular time of day.

A ToDo has a date but no time. ToDo records are like tasks. They must be completed on or by a date, but not 
necessarily by a particular time on that date (although it is typical for the task to be due by the end of the day). 
Such tasks might include writing a letter, doing research, or filing documents.

On the daily calendar, Events and ToDo's appear in different areas of the window.
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Add an Event to the calendar
 1.  Do one of the following:

 n Press Ctrl+Shift+V.

 n On the File menu, point to New Record and click Event.

 n On the Daily or Multi-day Calendar, double-click a time in the Events area.

 n On the Weekly or Monthly Calendar, right-click a date and select Add Record on the context menu. 
On the Add New Record window, select Event Record and click OK.

 n On the Events list, click the Add button.

The Event form opens.

 2.  Complete the Date and Time boxes, which are required.

 3.  In the Code box, click the arrow and select the classification code that best describes what kind of Event 
you are creating.

 4.  On the Regarding line, enter the Contact and/or Matter related to the Event.

 5.  In the other areas of the Primary tab, enter other information about the Event.

 6.  Click the Save & Close button.

Use Quick Entry to add an event
 1.  On the Daily or Multi-day Calendar, click a time slot.

 2.  Begin typing a description of the event.

The Quick Entry window opens, displaying the description you are typing.

 3.  In the Code box, click the arrow and select the classification code that best describes what kind of Event 
you are creating.

 4.  Optionally, enter additional information in the Memo area.

 5.  Click OK.

The event appears on the Calendar (and on the Event record list). You can double-click it to open the full 
Event form and add more information.
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Add a ToDo
 1.  Do one of the following:

 n Press Ctrl+Shift+T.

 n On the File menu, point to New Record and click ToDo.

 n On the Daily or Multi-day Calendar, double-click any part of the ToDo's area.

 n On the Weekly or Monthly Calendar, right-click a date and select Add Record on the context menu. 
On the Add New Record window, select ToDo Record and click OK.

 n On the ToDo's list, click the Add button.

The ToDo form opens.

 2.  Complete the Date box, which is required.

 3.  In the Code box, click the arrow and select the classification code that best describes what kind of ToDo 
you are creating.

 4.  On the Regarding line, enter the Contact and/or Matter related to the ToDo.

 5.  In the other areas of the Primary tab, enter other information about the ToDo.

 6.  Click the Save & Close button.
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Mark a ToDo as "done"
When you complete a ToDo, you should mark it as done. This causes the ToDo not to appear on the Alerts and 
Reminders window, and on the calendar the ToDo appears with a strike-through.

Do one of the following to mark a ToDo as done:

 n On the calendar, right-click the ToDo and select Mark as Done on the context menu.

 n Open the ToDo record and select the Done check box. Save and close the record form.
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Documents

Document records
When you add a file or document to Time Matters, a Document record is created. The Document record stores 
information about the file, including:

 n The location of the file

 n The Contact and/or Matter related to the file

 n The Staff(s) assigned to the document

 n A history of document versions

Note

A Document record is not the same thing as the file or document it refers to. The Document record is a set of 
information about the file or document. You can delete or change the Document record without affecting the 
document itself.
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Create a document by merging Time Matters record 
information

Create a merge template
Before you begin, you will need a merge template for the kind of document you want to create.

To view a list of merge templates:

 1.  In Time Matters, select File > Setup > Templates > Merge.

 2.  The List of Merge Templates window opens.

 3.  In the Record Type box, select the type of record whose information you want to merge into a 
document.

The window displays your existing merge templates for the selected record type.

If the kind of merge template you want does not appear, you will need to create a new template.

To create a merge template:

 1.  In Time Matters, go to File > Setup > Templates > Merge.

The List of Merge Templates window opens.

 2.  In the Record Type box, select the type of record whose information you want to merge into a 
document.

 3.  Click the Add button.

 4.  Select Program Level if you want the new template to be available to all Time Matters users, or select 
User Level if you want the template to be available only to you. Click OK.

The Merge Template Setup window opens.

LexisNexis® Time Matters® and Billing Matters® User Guide

Company Confidential.   Copyright © 2013 LexisNexis. All rights reserved. 36 of 102



 5.  On the Settings tab, type a description of the template in the Description box.

 6.  Click the Fields tab.
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 7.  Select each record field you want to make available in the merge and click Add to move it to the In 
Merge Data File list.

 8.  Click the Files tab.

 9.  In the Enter Complete Path and File Name box, type the directory path and file name you want to 
use for the new template.

 10.  Click the Create or Open Merge Form Field button.

Your word processing application opens.

 11.  Type the form letter (or other merge document) as you want it to appear.

 12.  Click the Insert Merge Fields icon on the word processor toolbar.

The Insert Field Name or Number window opens.

 13.  Select a field and click Insert to place it in the document at the cursor location. Repeat this for each field 
you want to include in the document.

 14.  Click Close to close the Insert Field Name or Number window.

 15.  Click Save and close or minimize your word processor.

 16.  On the Merge Template Setup window, enter the path and file name in the Specify Merge Output File 
box.

 17.  Select the Prompt for File Name When Merging check box.

 18.  Click OK to close the Merge Template Setup window.
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Merge Time Matters information into a document
To merge information from Time Matters into a document:

 1.  In Time Matters, tag the record(s) whose information you want to merge by clicking the check box beside 
the record(s) in a list.

 2.  On the main menu bar, click Process and then click Merge Records.

The Select Merge Template window opens.

 3.  Double-click the merge template you want to use.

The Merge File Names window opens.

 4.  Type the name and location of the output file in the Create Merge Output File Named area.

 5.  Click OK.
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Add an existing document to Time Matters
There are several ways you can import an existing document or file into Time Matters, creating a Document 
record for that file.

To add a single document, these methods are recommended:

 n Time Matters Save (TM Save): save the document to Time Matters while it is open in your word processor or 
viewer.

 n Drag and drop: drag a file from Windows Explorer onto the Time Matters window.

 n Send to Time Matters: right-click a file in Windows Explorer and select Send To > Time Matters.

 n Add a Document record: open a blank Document record and browse to the file you want to attach.

To add multiple documents, these methods are recommended:

 n Drag and drop: select multiple files in Windows Explorer and drag them onto the Time Matters window.

 n Send to Time Matters: select multiple files in Windows Explorer, right-click them, and select Send To 
> Time Matters.

 n Document Search: after completing a Document Search, tag the results, and click Process > Create 
Document Profile Records.

 

LexisNexis® Time Matters® and Billing Matters® User Guide

Company Confidential.   Copyright © 2013 LexisNexis. All rights reserved. 40 of 102



Save a document to Time Matters from your word processor
The Time Matters Save (or TM Save) button appears on the toolbar or ribbon of supported third-party 
applications, including Microsoft Word, Excel, PowerPoint, and Internet Explorer, Corel WordPerfect, Mozilla 
Firefox, and Adobe Acrobat and Reader.

If the button does not appear on your application's toolbar, do the following:

 1.  In Time Matters, click File, then click Setup, then click General, and then click Workstation Level.

 2.  Click the Word Processor Setup button or the Additional Program Setup button, depending on the 
type of third-party application you want to use.

 3.  Select the check box beside the application version for which you want to install the TM Save button.

 4.  Click OK.

 5.  Click OK to close the Workstation Level Setup window.

Save a document to Time Matters
 1.  In the supported third-party application, click the TM Save or Time Matters Save button on the 

toolbar or ribbon.

 2.  If you are not already logged in to Time Matters, the login window opens. Enter your ID and password.

The Time Matters Document form opens.

 3.  Enter information about the document on the form. It is recommended that you enter a Matter and/or 
Contact on the Regarding line, and complete the following additional boxes: Code, Description, and 
Staff.

 4.  Click the Save & Close button.
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Drag and drop documents into Time Matters
You can create Document records by dragging one or more files from Windows Explorer onto the Time Matters 
window.

 1.  Open Windows Explorer and Time Matters, and tile the windows so that both programs are visible.

 2.  Select one or more files in Windows Explorer and drag them onto the Time Matters window.

 3.  The results depend on where you drop the files:

 n If you drop a single file onto the Document list in Time Matters, a Document form opens. Complete 
and save the form.

 n If you drop multiple files onto the Document list, the Create Document Profile Records window opens. 
Enter information that is common to all the documents and click OK. If you selected the option to 
preview each Document record, the records will open one at a time, and you must click Save 
& Close each time (after adding any additional information needed).

 n If you drop files onto a Contact, Matter, Event, or ToDo, the Document records you create are 
automatically related to the target record. Some information on the Document form will be pre-filled 
with information from the target record.
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Send files to Time Matters from Windows Explorer
You can create Document records by selecting one or more files in Windows Explorer and using an option on the 
context menu.

 1.  In Windows Explorer, select one or more files. Right-click the selection and select Send to > Time 
Matters on the context menu.

The Create Document Profile Records window opens.

 2.  Enter information for the document(s) and click OK.

 3.  If you selected the option to preview each Document record, the records will open one at a time, and you 
must click Save & Close each time (after adding any additional information needed).
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Import a document using the Document form
You can bring an existing file or document into Time Matters using the Document form.

 1.  On the Document record list, click the Add button.

 2.  In the File Name box, specify the name and location of an existing file.

 3.  Enter additional information about the file. It is recommended that you enter a Matter and/or Contact on 
the Regarding line, and complete the following additional boxes: Code, Description, and Staff.

 4.  Click the Save & Close button.
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Create a document using information copied from a record
The Formattable Clipboard lets you copy information from multiple record fields and then paste the information 
into a document in a preconfigured format.

For example, instead of individually copying and pasting each address field on a Contact form, you can define a 
Formattable Clipboard template that copies all the address fields and pastes them in a correctly formatted block. 
You can even create a form letter and automatically insert selected information from a Contact.

Create a new document using the Formattable Clipboard
 1.  On the Document record list, click the Add button.

The Document form opens.

 2.  Enter information about the record on the form, It is recommended that you enter a Matter and/or 
Contact on the Regarding line, and complete the following additional boxes: Code, Description, and 
Staff.

 3.  In Area 4 of the form, click the Generate button and the Clipboard button.

 4.  Select a record from which to copy data to the clipboard:

 a.  Click the Data Source button.

 b.  In the Select Record Type box, click the arrow and select the type of record.

 c.  Click the Add button to open a list of records.

 d.  Select the record whose information you want to copy.

 e.  Click OK.

 5.  Select a clipboard template to use. This defines how the copied information will be formatted when it is 
pasted into the document:

 a.  Click the Template button.

 b.  In the left pane, select the application you want to open to create the document.

 c.  In the right pane, select the clipboard format you want to use.

 6.  Click the Create button.

The application associated with your selected template opens.

 7.  Paste the information in the clipboard by pressing CTRL+V or by clicking the Paste button on the toolbar 
or ribbon.

 8.  Save the document when you are finished.
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Create a new version of an existing document
A single Document record can be associated with multiple versions of a document.

 1.  Open a Document record.

 2.  In area 4 of the Document form, click the Generate button and the Existing button. 

 3.  Click the New Version button.

The current version of the document opens in the program associated with the document's file type.

 4.  Make the desired changes to the document, then save it.

 5.  In Time Matters, save and close the Document form.

The next time the record is opened, Area 4 of the form will show your updated version of the document 
as the current version. To view a list of previous versions, click the Versions button.
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Document sharing overview
Secure document sharing is a feature new in Time Matters 13. The feature provides access to an online portal to 
which you and your clients can upload and retrieve documents. 

Document sharing is performed on the Documents tab of the Matter form. From the list of files related to the 
Matter, you select the ones you want to share and the clients (or other recipients) to whom you want to provide 
access. Clients are notified by email when documents are shared with them, and can log in to the secure portal, 
view shared documents, and upload documents of their own to share with users at your firm.

You can set user permissions for each document you share, including permission to view, print, or edit the file. 
Using the administrative tools on the portal, you can also change or revoke user access to documents at any 
time.

For more information on document sharing, view the related topic links below.

Note

Your firm must have an active Annual Maintenance Plan (AMP) to enable the Document Sharing feature.
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Document sharing general questions

What are the online file-sharing capabilities in Time Matters 13?
Time Matters 13 includes an integrated online document-sharing service powered by secure file-sharing 
technology from WatchDox™ so you can share Time Matters documents directly with clients, experts, and 
other third parties.

The online file-sharing service in Time Matters offers you tight control over and protection of shared files. You 
can:

 n Define who can access the file—only the contact(s) associated with the matter, anyone with the same email 
domain as the contact(s) or everyone

 n Determine what they can do with the document—view, print or download

 n Prevent screen captures of the file by displaying only small areas at a time

 n Identify the timeframe that they can access the document

 n Track the file’s whereabouts at all times and maintain an audit trail for compliance purposes

 n Revoke access to files anytime

Your contacts are notified of shared files by email and can view the files from any Internet-connected computer, 
smartphone or tablet.

 

What is my storage limit as a firm or a user?
The online storage limit is  on a firm basis and allots up to 5 GBs of data (per firm) to be shared and available 
online at one time. LexisNexis reserves the right to modify this limit at any time.

 

What web site do I use to access shared documents away from the 
office?
Use the following web site address to access shared documents when you are away from the office.

https://clientshare.lexisnexis.com/
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Document sharing Time Matters user questions

How do I share documents securely with my clients?
The Document Sharing Portal lets you provide access to selected documents to clients and other people outside 
your firm.

To share documents:

 1.  Open the Matter whose related documents you want to share.

 2.  Click the Documents tab.

 3.  In the sublist of related documents, tag (click the check box beside) each document you want to share.

 4.  Click the Share button on the sublist toolbar.

 5.  The Share Documents window opens. See the section below for additional information about this 
window.

 6.  In the Select Recipients area, click the check box beside each Contact with whom you want to share the 
documents. 

Only Contacts related to the Matter appear in this list.

 7.  If a selected Contact does not have an email address, type the Contact's address in the box in the Email 
column.

 8.  If you want to add recipients that do not appear in the list, type their email addresses in the Additional 
Recipients box. Insert commas between addresses.

 9.  In the Sharing Options area, select the options you want.

 10.  Click the Share Documents button.

Document Sharing window
On this window, select document sharing options and the recipients who will have access to shared documents. 
The Document Sharing window opens after you tag one or more documents on the Documents tab of a Matter 
form and click the Share button on the sublist toolbar.

Documents Selected area

This box shows all the documents you tagged on the sub-list of the Documents tab. Documents that cannot be 

shared are indicated by the icon  . The reason the document cannot be shared is displayed in the Notes 
column.
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Select Recipients area

This box shows all Contacts related to the Matter whose documents are being shared.

Click the check box beside each Contact you want to share with. If a Contact does not have an email address, 
enter the address in the box in the Email column.

You can specify other recipients besides Contacts related to the Matter. To do so, enter the email addresses for 
those recipients in the Additional Recipients area. (When entering multiple email addresses, insert a comma 
between each address.)

Sharing Options area

Select the settings to apply to the documents you are about to share.

Screen Element Description

User permissions

Select whether users will be permitted to view the documents 
completely, view the documents through a spotlight-like 
viewing window, view and print the documents, or will have 
full access to view, print, and edit the documents.

Document access 
expires

Select one of the predefined expiration periods, or select 
Specific Date and enter the date on which document access 
will expire. You can enter a date by clicking the calendar icon 
and selecting a date on the calendar, or by typing the date in 
the format mm/dd/yyyy.

Grant file access to

Select whether to grant file access to the recipients only, to 
everyone who shares the same email domain as the 
recipients and who has a document sharing account, or to 
everyone with a document sharing account.

Watermark Select whether or not to place a watermark on PDF 
documents that you share.
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How long can I share files?
You can determine how long you would like to share each document. Your options are:

 n User specified date

 n 1 day

 n 3 days

 n 1 week

 n 2 weeks

 n 1 month

 n 3 months

 n 6 months

 n 1 year

 n Never

Note

The online file-sharing service is designed for short-term file-sharing with and access by clients and other third 
parties. It is not designed to be used for long-term file storage. Although we allow a "Never” expire option, 
LexisNexis reserves the right to require users to clean up dated files at any time.

 

What type of Time Matters documents can I share?
You can share any type of document that is in Time Matters or in a supported document management solution. 

For a list of currently-supported document management solutions, visit 
http://support.lexisnexis.com/timematters/record.asp?ArticleID=10934#5. 
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What Time Matters security applies to sharing documents?
If security is enabled, any security settings configured for a user for normal and private Document records 
(including special exceptions) will be enforced when each Document record is shared. If the TM user doesn’t 
have rights to change or view the selected Document record, they will not be allowed to share that file on the 
portal.

 

How do I remove document access from clients I've already 
shared with?
To remove document access from clients, perform the following from within WatchDox:

 1.  Click the My Document tab at the top of the document sharing portal.

 2.  Expand the Exchange branch in the navigation tree on the left.

 3.  Click on Sent Items.

 4.  Select the document(s) for which you want to remove client access.

 5.  Click on Permissions.

 6.  Click the Revoke Users option.

The Revoke Permissions page opens.

 7.  Select to revoke access to all user or specific users.
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 8.  If you select 'Revoke specific users,' type the email address for each user. 

 9.  In the Note to revoked users: text box, type the message you want displayed to revoked users who 
attempt to open the document. 

 10.  Click the Revoke button.
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How do  I change the sharing options after they are initially set?
To change the sharing options after they are initially set up, perform the following from within WatchDox:

 1.  Click the My Document tab at the top of the document sharing portal.

 2.  Expand the Exchange branch in the navigation tree on the left.

 3.  Click on Sent Items.

 4.  Select the document(s) for which you want to change the sharing options.

 5.  Click on Permissions.

 6.  Click the Edit Permissions option.

The Edit Permissions page opens.

 7.  Edit the options you need to change.

 8.  Click the Save Changes button.
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What happens when a document expires?
The document displays as expired in the Inbox of the recipient(s). They will not have the ability to download or 
view the file. If necessary, the recipient(s) can request an extension to their access period.

 

If I delete files from WatchDox online, will it delete them in Time 
Matters?
If you delete files from WatchDox, they are not deleted from Time Matters. When you upload a file in Time 
Matters to WatchDox, only a copy of the file is uploaded, therefore, deleting the file on WatchDox does not 
delete the file in Time Matters.

 

If I update a shared file, is it automatically updated on the sharing 
portal?
No. Only a copy of the file as it exists at the time of sharing is uploaded to WatchDox and updating the file in 
Time Matters does not automatically update the file on WatchDox. For your client to receive the updated 
version of the file, you need to re-share the file with them (sharing that version of the file).

 

How do I get a shared file from a client back into Time Matters?
To have the file saved into Time Matters, download and save the file locally or within your firm’s network. Then 
create a Document record linked to the file, or update the file linked to an existing Document record.

 

When logging into WatchDox for the first time, what do I need to 
do?
Although Time Matters has created an account for you, you still need to create a password and secret question 
for your account. Refer to the section on creating a user account on the document sharing portal.
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Document sharing client user questions

How do I create a user account on the document sharing portal?
The first time someone shares a document with you, a notification email is sent to you with a link to the 
document sharing portal.

 1.  Click the link in the notification email to go to the document sharing portal (powered by WatchDox).

 2.  Click the Create Account tab.

 3.  In the Name box, type your name. This is the name used by default in the subject line of emails 
generated when you send documents to other people.

 4.  In the Email box, type the email address to which the notification email was sent.

 5.  In the Password and Retype Password boxes, type the password you want to use. It is highly 
recommended that your password includes at least three of the following: uppercase letters, lowercase 
letters, numbers, and special characters (such as $, #, !, etc.).

 6.  Click the arrow beside the Select Secret Question box and select a question from the drop-down list.  
This question is used to verify your identity if your password is lost or forgotten.
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 7.  In the Answer box, type the answer to the question you selected.  (It is recommended that you use a 
simple, one word answer that will be easy to remember.)

 8.  Click Create Account.

An email is sent to the email address provided on the account, to authenticate the email address. 

 9.  In the authentication email, click on the link to finalize the creation of your user account.

 

How do I log in and log off of the document sharing portal?

Log in to the portal:

 1.  Go to the document sharing portal URL: https://clientshare.lexisnexis.com 

 2.  On the Log in tab, type your email address in the Email box and your password in the Password box.

 3.  Optionally, select the Remember me box to store your login information so that you will not have to 
enter it on subsequent visits. (For the security of your documents, only use the "Remember me" option 
on a secure, password-protected computer.)

 4.  Click the Log In button.
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Log off of the portal:

 1.  Click the arrow beside your user name (email address) in the top right corner of the window.

 2.  Click Log Off.

 3.  Click OK.

 

How do I restore access when my password is lost?
 1.  On the document portal login page, click the link Forgot password.

 2.  In the Email box, type the email address you use to log in to the document sharing portal.

 3.  Click Continue.

 4.  Locate and open the "Restore Password" email that was automatically sent to you.

 5.  Click the link in the email.

 6.  In the Answer box, type the answer to the secret question you selected during account creation.

 7.  Click Retrieve Password.

 8.  In the New Password and Retype New Password boxes, type the password you want to use.

 9.  Click Submit.

 10.  Click the log in link.

 11.  Log in using your new password.

 

How do I change my password on the document sharing portal?
 1.  Click the arrow beside your user name (email address) in the top right corner of the window.

 2.  Click Change Password.

 3.  In the Current Password box, type the password you current use to log in.

 4.  In the New Password box, type the password you want to use.

 5.  In the Retype New Password box, re-type the same password you entered in step 4.

 6.  Click Submit.

 7.  Click OK to continue and close the new broswer/tab, once your password has been successfully changed.
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How do I view and edit my account info on the document sharing 
portal?
 1.  Click the arrow beside your user name (email address) in the top right corner of the window.

 2.  Click My Account.

 3.  On the Account Info tab, view your account type, administrative contacts, and subscription expiration 
date.

 4.  On the User Info tab, you can view and edit your name and other personal information. Click the 
Update button when you are finished.

 5.  On the Account Management tab, you can select or clear the option to receive daily updates by email 
regarding document activity. Click the Update button when you are finished.

 

How do I view documents on the document sharing portal?
 1.  On the document sharing portal, click the My Documents tab at the top of the window.

 2.  To view documents you have received, expand the Exchange branch in the navigation tree on the left 
and click Inbox.

 3.  To view documents you have sent,  expand the Exchange branch in the navigation tree on the left and 
click Sent Items.

The list of documents appears in the center area of the window.

 4.  Click the header of any column to sort that column by ascending or descending order. You can also resize 
columns by dragging the left or right border between column headers.
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How do I download documents on the document sharing portal?
 1.  Select the check box beside each document you want to download.

 2.  Click the Download button on the toolbar.
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How do I send a document using the document sharing portal?
 1.  On the document sharing portal, click the My Documents tab at the top of the window.

 2.  Click the Send a Document button on the toolbar below the Documents tab.

The Send Protected Documents window opens.

 3.  In the To box, type the email address of each recipient.

 4.  Optionally, modify the default text in the Subject box.

 5.  Type the message you want to send in the email notification in the text box.

 6.  Optionally, click Recipient Permissions and set the following options:

 n User permissions: Select whether recipients will have full access to view, print, and download the 
shared document(s), or access to view and print, view only, or view a limited "spotlight" region of the 
document(s).

 n Document access expires: Select the date when these recipients will no longer have access to the 
document(s).
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 n Grant file access to: Select whether to give access to the selected recipients only (recommended) 
or to a broader group.

 n Watermark: Select whether to apply a watermark to PDF documents.

 7.  Click Attach File.

 8.  Browse to the document(s) you want to share. Select the document(s) and click Open.

 9.  Click Send.
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How do I search for a document on the document sharing portal?
 1.  On the document sharing portal, click the My Documents tab at the top of the window.

 2.  Select Exchange in the navigation tree on the left.

 3.  Click the Filter icon (   ) on the toolbar.

 4.  To find documents matching a set of criteria, expand the filter categories on the left and select the check 
boxes beside the criteria you want to include. For example, you could find PDF documents under 1MB by 
selecting the following boxes: PDFs, 0-50KB, 50KB - 200KB, and 200KB - 1MB.

 5.  To find documents by search terms, use the search box at the top of the left pane. You can specify 
whether you are searching for a document by name, by email address (of the document's owner), or by 
content within the document.

 n To search by document name, type docname: followed by a portion of the name you want to find.

 n To search by email address, type owneremail: followed by a portion of the email address.

 n To search by content, type content: followed by the keywords you want to find within the document.

 n You can combine these search types into a longer statement such as the following:

docname: agreement AND owneremail: rsb@browncamposmarshall.com AND content: "Barry 

Able"
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How do I mark a document as read or unread on the document 
sharing portal?
 1.  Select the check box beside each document you want to mark.

 2.  Click the arrow beside the Actions button on the toolbar and select Mark as Read or Mark as Unread.

 

How do I delete a document on the document sharing portal?
 1.  Select the check box beside each document you want to delete.

 2.  Click the arrow beside the Actions button on the toolbar and select Delete.
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Communications

View your email
Each Time Matters user (not Staff) has a personal inbox for email sent to their account.

 n Click the Mail menu and then click Personal Inbox.

You can also view email that has been moved from your personal inbox to the Email list.

Click the File menu, point to Email List, and click All Email.
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Create and send email
 1.  Click the Mail menu and then click Personal Inbox.

 2.  Click the New button on the Inbox toolbar.

An Email record form opens.

 3.  Complete the Subject box.

 4.  If the email is regarding a Contact or Matter, enter that Contact and/or Matter in the boxes on the 
Regarding line.

 5.  In the To box, type the addresses of the email recipients. You can also click the lookup button beside the 
box to select recipients from among Contacts, Staff, and distribution lists.

 6.  In the Message area, type the message you want to send.

 7.  To attach a file, do the following:

 a.  Click the Attachments button.

 b.  Click the arrow beside the Add button.

 c.  Select File or TM Document, depending on how you want to identify the attachment.

 d.  Locate and select the file(s) you want to attach.

 8.  When you are ready to send the email, click the Send button on the Email form toolbar.
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Send instant messages to other Time Matters users
 1.  Click the View menu and then click Messenger Window.

The Messenger opens.

 2.  Click the Add button. 

The Message form opens.

 3.  Click the lookup button beside the To box to select a Time Matters user as the recipient of the message.

 4.  Type your message in the Message area.

 5.  If you want to flag the message as urgent, click the Urgent button.

 6.  Click Send when you are ready to send the message.
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Create a Phone record
 1.  Do one of the following:

 n Press Ctrl+Shift+P.

 n On the File menu, point to New Record and click Phone Call.

 n On the Phone Calls list, click the Add button.

The Phone Call form opens.

 2.  Complete the Date and Time boxes, which are required.

 3.  In the Code box, click the arrow and select the classification code that best describes the nature of the 
phone call.

 4.  On the Regarding line, enter the Contact and/or Matter related to the phone call.

 5.  If the record is for an incoming call, enter the name of the caller or click the lookup button to select from 
a list of Contacts.

 6.  If the record is for an outgoing call, click the In From button to toggle the label to Out To. Then enter 
the name of the recipient or click the lookup button to select from a list of Contacts.

 7.  In the other areas of the Primary tab, enter other information about the phone call.

 8.  Click the Save & Close button.
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Reports

Print a standard report
 1.  Click the Report menu and then click Standard Reports.

The Standard Reports window opens.

 2.  Select the tab related to the type of report you want to print: Billing, Transactions, Tax, Staff,  or 
Setup.

 3.  Select the report level: Program, User, or both Program and User.

 4.  On the Format tab, select the report you want to create.

 5.  On the Filter tab, select the criteria a record must meet to be included in the report. (These options are 
different for each report format.)

 6.  On the Options tab, select any additional report options you want. (These options are different for each 
report format.)

 7.  Click the Printer button.

The Print window opens.
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 8.  Select the printer you want to use and set other print options.

 9.  Click OK to print the report.
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Export a record list as an Excel spreadsheet
 1.  Open the list you want to export.

 2.  Right-click the list toolbar and select Edit Columns. 

The Edit List Fields window opens.

 3.  Ensure that the In List box includes the columns you want to include in the spreadsheet, ordered the 
way you want. Select the name of a column in the Available Fields box and click the Add button to 
move it to the In List box. Select the name of a column in the In List box and click the Up or Down 
button to move it earlier or later in the list. Columns earlier in the list appear closer to the left.

 4.  Click OK.

 5.  Optionally, click the Search button on the list toolbar and enter search criteria to filter the list to show 
only the records you want to include in the spreadsheet. Click OK.

 6.  Click the Send to Excel button on the list toolbar.

(If the button does not appear on the toolbar, click the Options button to open the List Options window, 
select the List Toolbar tab, select Send to Excel in the Available Buttons box and click Add to move it to 
the Show on Toolbar box. Click OK to save your changes.)

The list is exported to an Excel spreadsheet.
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Time and billing

Create a timesheet
 1.  A timesheet is for entering time and expenses on an ongoing basis.

 2.  On the Billing menu, click Timesheet.

The Timesheet window opens.

 3.  Click the Add button on the Timesheet toolbar.

A Billing Item form opens. The Date and Time boxes are pre-filled with the current date and time. You 
can change them if necessary.

 4.  By default, the form is for entering time. To enter expenses, click the Time Code button. The button 
label changes to Exp Code, and several fields on the form are changed to reflect expense information.

 5.  Complete the Code, Description, Staff, and Regarding boxes.

 6.  In the lower area of the form, enter information about the amounts and rates.

 7.  Click the Save & Close button. The entry appears on the Timesheet window.
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Set up basic billing
 1.  Click the File menu, point to Setup, then point to General, and then click Program Level.

 2.  Click the Links tab and the Billing subtab. (If the Billing subtab does not appear, click the main Billing tab 
and ensure that the Activate Billing Matters check box is not checked.)

 3.  Click the Activate Billing check box.

 4.  Select Basic Billing in the Select Billing Link drop-down list.

 5.  Click the Set Billing Options button. The Time Matters Billing Setup window opens.

 6.  Set options on the General tab:

 a.  Select whether to bill by Contacts, Matters, or Contacts and Matters.

 b.  Type the number to use for the first (or next) invoice you create in the Next Invoice Number 
box.

 c.  Select Allow changes to Billing Form if you want to enable customization of Billing forms.

 d.  Select Allow Time Matters Records to be billed more than once if you will allow records to 
be billed multiple times.

 e.  Select Allow Billed Recordsto be on more than one Time Matters Invoice if you will allow 
billed records to show on more than one invoice.

 7.  Click the Rates tab to add or modify rate tables.

 8.  Click the Setup tab to modify additional billing options, such as setting a global rate for your business, a 
default billing basis, and a default rate level.

 9.  Click the Address tab to select the fields used to complete the Bill To area of invoices.

 10.  Click OK to close the Time Matters Billing Setup window.

 11.  Click OK to save your changes and close the Program Level Setup window.

 12.  To activate billing for each user that will need access to the billing functions, go to File > Setup > 
General > User Level.

 13.  Select a user from the drop-down list in the top left corner of the User Level Setup window.

 14.  Click the Links tab and the Billing subtab.

 15.  Select the Activate Billing check box and click the Set Billing Options button. The Time Matters 
Billing Link Options window opens.

 16.  Select whether to use Program Level settings or to specify individual user settings for the available 
options.

 17.  Click OK to close the Time Matters Billing Link Options window.

 18.  Click OK to save your changes and close the User Level Setup window.
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Create an invoice
 1.  On the Billing menu, click Invoice List.

The Invoice list opens.

 2.  Click the Add button on the list toolbar.

An Invoice form opens.

 3.  If billing by contacts, select a contact for the Regarding field. If billing by Matter or Contact-Matter, or 
with Matter as a default, select a Matter for the Regarding field.

 4.  Billing Address will complete automatically when a contact or Matter is selected in the Regarding field. 
Shipping Address may be completed manually and is not necessarily the same at the billing address.

 5.  In Invoice settings, enter the date for the invoice in the Invoice Date field.

 6.  Select the Terms in the Terms field to apply to this invoice.

 7.  Enter the due date for payment of this invoice in the Due Date field.

 8.  Enter the purchase order number, if required, in the P.O. Number field.

 9.  In the Invoice Details area, enter the Invoice Number. Note that this field may be grayed out depending 
on how your administrator set up billing for your firm.

 10.  Select the To be Printed check box if the invoice is to be printed at a future date.
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 11.  In the Invoice Items area, add billing items to the invoice in 2 ways; the first method is to type them 
directly. The second method is to click the Add Billing items button to open the Billing Item List.

 12.  To print the invoice immediately once it’s complete, click Print.

 13.  Click Save & Close to save this invoice and close the window.
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Print a prebill
 1.  On the Billing menu, click Print Pre-bills.

The Print Pre-bills window opens.

 2.  On the Matter tab, select criteria to include pre-bills for specific Matters.

 3.  On the Charges & AR tab, set options to define how work-in-progress will be filtered.

 4.  On the Options tab, select options to broaden or narrow the filter of items for which pre-bills will be 
printed.

 5.  On the Include tab, define information that will not be printed on the bill.

 6.  Click Print. The printed copies can be distributed for review.
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Create a bill
 1.  On the Billing menu, click Create Bills.

The Create Bills window opens.

 2.  On the Matter or Contact tab, specify the client records that are ready for billing.

 3.  On the Charges & AR tab, set options to define how work-in-progress will be filtered.

 4.  On the Options tab, select options to broaden or narrow the filter of items for which pre-bills will be 
printed.

 5.  Click the Print button.
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Post or undo a bill
 1.  On the Billing menu, click Post or Undo Bills.

The Post or Undo Bills window opens.

 2.  Tag the bills you want to post or those that you want to undo.

 3.  Click the Post button to post the tagged bills, or click the Undo button to undo the tagged bills.
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PCLaw link

PCLaw link overview
With the PCLaw link, you can easily capture the billable hours you spend working in Time Matters and send that 
information to PCLaw for billing.

 

Before you install
Do the following before you set up the PCLaw link:

 n Back up your Time Matters 13 database.

 n Back up your PCLaw database.

 n If necessary, set up the PCLaw Remote Client Server. This is necessary if the full PCLaw client (version 9.30 
or later) is not installed on each computer where the PCLaw link will be used.

Instructions for each of these procedures follow.
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Back up your Time Matters database
 1.  Select File > Backup Time Matters Data from the Time Matters menu.

The Time Matters Backup window opens.

 2.  (Optional) In the Shared Files Backup box, type or select a different backup file name.

 3.  (Optional) Select the types of files (documents and/or email attachments) that you want the backup to 
skip.

 4.  Select the Backup now option from the Backup Options... area.

 5.  Click OK.

The Begin Server Backup Now window opens.

 6.  Click Yes. When the SQL database backup is complete, the Server Backup Completed window opens.

 7.  Click OK.

The Begin Backup Now window opens.

 8.  Click Yes.
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 9.  When the process is complete, click OK to close the window.

Note

Time Matters SQL database backups are stored in a different location than backups of Time Matters 
document and email files. The default location of SQL backup data is: 
C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Backup or C:\Program Files(x86)
\Microsoft SQL Server\MSSQL.1\MSSQL\Backup

 

Back up your PCLaw database
 1.  In PCLaw, go to File > Backup/Restore > Backup Data.

A message window opens, reminding you to ensure that you are the only user running PCLaw. If other 
users are running PCLaw, wait until they have exited PCLaw before proceeding.

 2.  Click Yes to continue.

 3.  If a window opens displaying a message about what information is included in the backup, click OK to 
close the window and continue.

The PCLaw Archive - Export File window opens.

 4.  Select a location to save your backup file, and enter a file name. 

Note

It is recommended that you include the current date in the file name, for easy identification and to avoid 
overwriting older backup files.

 5.  Click Save to create the backup file.

 

Set up the PCLaw Remote Client Server
Perform these steps on a computer with the full PCLaw client installed, and with network access to other 
computers that will use the Remote Client.

 1.  Create a shared folder on the computer. This folder will be used by remote clients to send requests to 
PCLaw.

Note

A good idea is to create the shared folder within the existing PCLaw data path, such as:
\\computerName\PCLaw Data\Data\Remote

 2.  Close all open applications on the computer.

 3.  In PCLaw, go to Options > Connection Settings.

The Connections Settings screen opens.
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 4.  Select the Use This Set of Books when Connecting with Other Programs check box.

 5.  Click Configure Remote Server Settings.

The PCLaw Remote Client Server Configuration Utility screen opens.

 6.  Enter the full path to the folder you set up in step 1.

Note

Use Universal Naming Convention syntax. For example, \\computerName\PCLaw 
Data\Data\Remote

 7.  Click Next.

The PCLaw Link Service: Log on As window opens.

 8.  Enter your domain\user name, password, and confirmation password.

The PCLaw Link Service Installed window opens.

 9.  Click OK.

A second PCLaw Link Service: Log on As window opens.

 10.  Enter your domain\user name, password, and confirmation password.

 11.  Click OK.

The PCLaw Log Service Installed window opens.

 12.  Click OK.

A third PCLaw Link Service: Log on As window opens.

 13.  Enter your domain\user name, password, and confirmation password.

 14.  Click OK.

The PCLaw Time Matters Service is Running window opens.

 15.  Click OK.

Note

If the Time Matters login screen opens, the Server Utility is creating a link to Time Matters to send the 
location of the redirect path for the Remote Client. (Login may not be required at this time.)

The Action Complete window opens to confirm registration.

 16.  Click Done.

 17.  Open Time Matters and complete the PCLaw Link Setup at the Program Level and PCLaw Link Setup at 
the User Level to re-initialize the PCLaw Link.
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Note

The system must be restarted to restart the services and to load the link from the Client after you have 
re-initialized the PCLaw Link.

 

Set up the link in PCLaw
 1.  Open PCLaw with the set of books you want to use to link to Time Matters.

 2.  Click the Options menu and then click Connection Settings.

 3.  The Connection Settings window opens.

 4.  Select Use this Set of Books when Connecting with Other Programs.

 5.  Click OK.

 

Set up the link in Time Matters
 1.  In Time Matters, click File > Setup > General > Program Level.

The Program Level Setup window opens.

 2.  Click the Billing tab.

 3.  If the Activate Billing Matters check box is selected, do the following:

 a.  Clear the check box.

 b.  Click OK.

 c.  Close and reopen Time Matters.

 d.  Open the Program Level Setup window.

 4.  Click the Links tab.

 5.  On the Billing subtab, select the Activate Billing check box.

 6.  In the Select Billing Link box, click the arrow and select PCLaw.

 7.  Click the Set Billing Options button.

 8.  If the full PCLaw client is not detected on this computer, Time Matters will prompt you to install the 
PCLaw Remote Client. See "PCLaw Remote Client Setup" for additional information.

Time Matters initializes the PCLaw link. When the link has loaded, the PCLaw Link Setup window opens.

 9.  On the General tab, select the settings you want. For a description of each item on this tab, see PCLaw 
Link Options.

 10.  On the Billing Options tab, select the default settings you want. For a description of each item on this tab, 
see PCLaw Link Options.
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Note

These settings can be modified for each user in User Level Setup.

 11.  Click OK.

 12.  If there is PCLaw link data from a previous version of Time Matters, you will be prompted to convert the 
existing data for Time Matters 13.0. Follow the on-screen instructions to create a backup of your 
database and begin the data conversion.

 13.  Click OK to close the Program Level Setup window.
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Set up the PCLaw billing link with Time Matters
This is an overview of the steps needed to set up the PCLaw billing link.

 1.  Verify that your installed version of the PCLaw software is compatible with the Time Matters® software.

 2.  Create a backup of the Time Matters and PCLaw software databases.

Note

Restoring a backup is the only way to reverse the outcome of a synchronization.       

 3.  Configure the PCLaw book set to connect with third party applications.

 4.  Disable Billing Matters to enable linking to a third party billing application.

 5.  Configure the Time Matters software to link with the PCLaw software.

 6.  Associate Time Matters Matters with PCLaw Matters.

 7.  Click File and select Synchronize and PCLaw if you want to move data into Time Matters from PCLaw.

Note

Changes made to Time Matters contact or matter records linked to the PCLaw software transfer upon 
saving and closing the record. Changes made to PCLaw clients or matters linked to the Time Matters 
software transfer through manual synchronization.Restoring a backup is the only way to reverse the 
outcome of a synchronization.       
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Time Entry Advisor

Time Entry Advisor overview
The Time Entry Advisor helps you keep track of work that has not yet been billed.

The Time Entry Advisor window has three tabs:

 n Uncharged Time: view billable records and send them to your billing system

 n Awaiting Billing: view records sent to billing that have the Hold Record box selected

 n Ignored Items: view records for which a decision was made not to bill
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View records on the Time Entry Advisor

View uncharged time
The Uncharged Time tab of the Time Entry Advisor shows records that are marked as Billable, but have no 
corresponding billing record.

To view records representing uncharged time, do the following:

 n On the Billing menu, click Time Entry Advisor.

The Time Entry Advisor window opens, displaying the Uncharged Time tab.
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View records awaiting billing
The Awaiting Billing tab shows records for which BOTH of the following are true:

 n The record has been sent to billing

 n The Hold Record check box is selected on the record form

To view records awaiting billing:

 1.  On the Billing menu, click Time Entry Advisor.

 2.  The Time Entry Advisor window opens.

 3.  Click the Awaiting Billing tab.
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View ignored records
The Ignored Items tab of the Time Entry Advisor shows records that have been manually removed from the 
Uncharged Time tab.

To view ignored records:

 1.  On the Billing menu, click Time Entry Advisor.

 2.  The Time Entry Advisor window opens.

 3.  Click the Ignored Items tab.
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Other Time Entry Advisor tasks

Filter the list of records shown on the Uncharged Time tab
 1.  In the Date Range area, do one of the following:

 n Click the arrow and select a predefined date range (such as "Last Month") from the list.

 n Click the arrow and select Custom from the list. Type a start date in the From box and an end date in 
the To box. You can also click the calendar icon beside each box to select a date.

 2.  In the Record Types area, select the check box beside each record type you want to view on the list. 
Deselect the check boxes beside record types you want to hide.
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 3.  In the Contact/Matter/Staff area, do the following:

 a.  To view records for a specific Matter, type part or all of the Matter name in the Matter Ref box, or 
type part or all of the Matter number in the Matter No box. You can also click the lookup button 
beside either box to select from a list of Matters.

 b.  To view records for a specific Contact, type part or all of the Contact name in the Contact box, or 
type part or all of the Client number in the Client No box. You can also click the lookup button 
beside either box to select from a list of Contacts.

 c.  To view records for a specific Staff, type the Staff's initials in the Staff box. You can also click the 
lookup button to select from a list of Staff.

Note: To view items with no Staff assigned to them, leave the Staff box empty.

 4.  Click the Update List button to filter the list by the selected criteria.

 

Change records on the Time Entry Advisor
 1.  Select the check box beside each record you want to change.

 2.  Click the Change Records button.

 3.  The Time Matters Change Express window opens.

 4.  Create a new template or use an existing one. Follow the instructions on the screen to apply changes to 
the selected records.

 

Send records to Microsoft Excel
To create a Microsoft Excel spreadsheet showing information on the Uncharged Time tab, do one of the 
following:

 n To include all records shown on the tab, click the Send to Excel button.

 n To include specific records, select the check box beside each record you want to include, and then click the 
Send to Excel button.

 

View uncharged time for a specific Matter or Contact
 n Right-click a Matter on the Matter list, or a Contact on the Contact list. On the shortcut menu, select Time 

Entry Advisor.

The Time Entry Advisor window opens, displaying records related to the selected Matter or Contact on the 
Uncharged Time tab.
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Bill uncharged time discovered by the Time Entry Advisor
 1.  On the Billing menu, click Time Entry Advisor.

 2.  The Time Entry Advisor window opens, displaying the Uncharged Time tab.

 3.  Optionally, enter criteria in the Filter by area and click Update List to show only records that match 
your criteria.

 4.  Select the check box beside each record you want to bill.

 5.  Click the Send to Billing button.

 6.  If multiple records were selected, select either the option to confirm each record before billing or the 
option to process all the selected records without confirmation. Click OK.
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Time Matters for Microsoft Office

Overview of Time Matters for Microsoft Outlook
Time Matters for Microsoft Outlook gives you access to information about your Time Matters Contacts and 
Matters while you work in Outlook.

When this feature is enabled, the Time Matters pane appears on the right side of the Outlook window. On the 
Time Matters pane, you can:

 n View summary information about the Contacts and Matters related to an Outlook email or appointment

 n Search for Contacts and Matters in your Time Matters database

 n Open a full Contact or Matter form for editing

 n Enter time and expenses

 n Create a new email to send to a Contact
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Overview of the Time Matters pane in Outlook

You can expand and collapse the Time Matters pane by clicking the arrow beside the pane's label: 
.

When collapsed, the Time Matters pane shows the following:

 n The Time Matters login currently in use

 n The currently selected Outlook contact (by default, the sender of the selected Outlook email or the organizer 
of the selected Outlook appointment)

 n The number of Time Matters Contacts and Matters related to the selected Outlook Contact

 n Buttons to show details of related Contacts and Matters

When expanded, the Time Matters pane shows the following:

 n A Search box to find Time Matters Contacts and Matters

 n Tabbed views of related Contacts and Matters

 n Options to open the full Contact or Matter form, and to enter time or expense for a Contact or Matter

 

Collapsed pane Expanded pane
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Install Time Matters for Microsoft Outlook

Requirements
To use Time Matters for Microsoft Outlook, you must have the following:

 n Microsoft Outlook 2007 with Service Pack 3, Microsoft Outlook 2010, or Microsoft Outlook 2013

 n Microsoft Windows XP (32-bit only), Windows Vista, Windows 7, Windows 8, Windows Server 2003, 
Windows Server 2008 R1/R2, or Windows Server 2012

 

How to enable Time Matters for Microsoft Outlook
Time Matters for Microsoft Outlook might have been enabled during the installation of the Time Matters client. If 
it is enabled, the TM for Outlook tab on the Outlook ribbon will include a Show/Hide Pane button to hide or 
show the Time Matters pane.

If Time Matters for Microsoft Outlook is not already enabled on your computer, perform the steps in the 
following sections.

Enable the feature
 1.  In Time Matters, click the File menu, point to Setup, point to General, and click Program Level.

The Program Level Setup window opens.

 2.  On the General tab, select the Enable Web Access check box.

 3.  Click OK.

 4.  Click the File menu, point to Setup, point to General, and click Workstation Level.

The Workstation Level Setup window opens.

 5.  Click the Additional Program Setup button.

The Additional Integration Setup window opens.

 6.  Select the Time Matters for Microsoft Outlook check box.

 7.  Click OK.

 8.  Click OK to close the Workstation Level Setup window.
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If the Time Matters pane does not appear in Outlook
If all the requirements are met and you have enabled the feature in Time Matters, but the Time Matters pane 
still does not appear in Outlook, try the following:

 n If the TM for Outlook tab appears on the Outlook ribbon, click the Show Pane button.

 n Check your Outlook Add-Ins settings. "LexisNexis Time Matters for Outlook Add-In" should appear in the list 
of active add-ins. If it is listed as inactive or disabled, use Outlook's add-in management tools to make it 
active.

 n Make sure that the LexisNexis Practice Management Common API service is installed and running on your 
computer.
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Log in to Time Matters for Microsoft Outlook
 1.  Expand the Time Matters pane.

 2.  Enter your Time Matters user ID in the User ID box.

 3.  Enter your Time Matters password in the Password box.

 4.  Click the   button.
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View Contacts and Matters in Time Matters for Microsoft 
Outlook

Outlook Contacts versus Time Matters Contacts
Two different types of contacts are displayed on the Time Matters pane:

 n Outlook Contacts are the persons or groups that appear in the header area of emails (the sender and 
recipients) or appointments (the organizer and attendees).

 n Time Matters Contacts are a separate set of records, stored in your Time Matters database.

Typically, an Outlook Contact is related to only one Time Matters Contact. That Time Matters Contact, in turn, 
might be related to one or more Matters. So when you select an Outlook Contact on the Time Matters pane, it is 
typical to see one related Time Matters Contact and a small number of related Matters.

When you synchronize Time Matters with Microsoft Outlook, many of your Outlook Contacts are matched to 
Time Matters Contact records. When Contacts are matched, selecting the Outlook Contact will make its Time 
Matters Contact counterpart available to view, along with any Matters related to it.

Note

Only Contacts and Matters assigned to you are visible in Time Matters for Microsoft Outlook. This means that 
the Staff associated with your user ID must appear in the Staff box of the Contact or Matter record.

 

View Contacts and Matters
In Outlook, click an email or calendar appointment to highlight it.

The Time Matters pane displays the number of Outlook Contacts on the email or appointment. It also displays 
the number of Time Matters Contacts and Matters related to the active Outlook Contact (the one whose name 
is displayed).

You can change the active Outlook Contact by pointing to the arrow beside that Contact. A flyout window 
opens, displaying a list of all the Outlook Contacts on the email or appointment. Click a Contact to make it the 
active one. The related Time Matters Contacts and Matters will be updated.

When the Time Matters pane is collapsed
 n Point to the Contact button to view a flyout window with a list of Time Matters Contacts related to the active 
Outlook Contact. Click a Time Matters Contact in the list to display details in the flyout window.

 n Point to the Matter button to view a flyout window with a list of related Matters. Click a Matter in the list to 
display details in the flyout window.
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When the Time Matters pane is expanded
 n Click the Contact tab to view a list of Time Matters Contacts related to the active Outlook Contact. Click a 
Time Matters Contact in the list to display details for that Contact.

 n Click the Matter tab to view a list of related Matters. Click a Matter in the list to display details for that Matter. 
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Search for Contacts and Matters in Time Matters for 
Microsoft Outlook
 1.  Expand the Time Matters pane. (When the pane is collapsed, clicking the Search button will expand it.)

 2.  Click the arrow beside the Search box and select Contact or Matter.

 3.  Type a portion of the Contact Name or the Matter Reference in the Search box.

 4.  Press ENTER or click the   button.

A list of records matching the search text appears.

Note

Only Contacts and Matters assigned to you are visible in Time Matters for Microsoft Outlook. This means that 
the Staff associated with your user ID must appear in the Staff box of the Contact or Matter record.
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Enter time and expense using Time Matters for Microsoft 
Outlook
You can enter time and expenses for a Contact or Matter that you are viewing in Time Matters for Microsoft 
Outlook. 

 1.  Expand the Time Matters pane.

 2.  Locate the Contact or Matter for which you want to enter time or expense. You can do this by selecting 
an email or appointment related to the Contact or Matter, or by using the Search feature to find the 
Contact or Matter.

 3.  Double-click the Contact or Matter to display its details.

 4.  Click the   button to display the time/expense entry form.

 5.  At the top of the time/expense entry form, select Add Time or Add Expense.

Add Time Add Expense

To add time, do the following:

 a.  In the Description box, enter a short description of the time entry.

 b.  Optionally, enter a different date in the Date box (the current date is used by default).
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 c.  Enter a start time and end time in the respective boxes.

 d.  Enter a code in the Code box. You can click the   button to select the code from a list.

 e.  Optionally, enter additional information about the time entry in the Memo box.

To add expense, do the following:

 a.  In the Description box, enter a short description of the expense entry.

 b.  Optionally, enter a different date in the Date box (the current date is used by default).

 c.  In the Quantity box, enter the number of expense units.

 d.  In the Price box, enter the price per unit.

 e.  Enter a code in the Code box. You can click the   button to select the code from a list.

 f.  Optionally, enter additional information about the time entry in the Memo box.

 6.  If you want to mark the time or expense entry as Private, select the Private check box at the top of the 
time/expense entry form.

 7.  Click Save.

 

LexisNexis® Time Matters® and Billing Matters® User Guide

Company Confidential.   Copyright © 2013 LexisNexis. All rights reserved. 102 of 102


	Getting Started
	Log in
	Start the application in Training Mode
	Change your password
	Change your password when not required

	Use the Navigator to open program features
	View a list of records
	Locate a record on a list
	To use QuickPik:
	To use the Search box:

	Open a record for viewing or editing

	New features
	Client Portal online document sharing
	Automatic data backup
	Sort records by column headers
	Color-code matters in the calendar
	Set the Header Color option for matters
	Color code a matter


	Clients and Matters
	View a Contact
	Add a Contact
	Add a Contact using the New Contact Intake wizard
	Add a Contact using the Contact form
	Add a Contact related to a specific Matter

	View a Matter
	Add a Matter
	Add a Matter using the New Matter Intake wizard
	Add a Matter using the Matter form

	Associate a Contact with a Matter

	Calendar
	View the calendar
	Events and ToDo's
	Add an Event to the calendar
	Use Quick Entry to add an event

	Add a ToDo
	Mark a ToDo as done

	Documents
	Document records
	Create a document by merging Time Matters record information
	Create a merge template
	Merge Time Matters information into a document

	Add an existing document to Time Matters
	Save a document to Time Matters from your word processor
	Save a document to Time Matters

	Drag and drop documents into Time Matters
	Send files to Time Matters from Windows Explorer
	Import a document using the Document form
	Create a document using information copied from a record
	Create a new document using the Formattable Clipboard

	Create a new version of an existing document
	Document sharing overview
	Document sharing general questions
	What are the online file-sharing capabilities in Time Matters 13?
	What is my storage limit as a firm or a user?
	What web site do I use to access shared documents away from the office?

	Document sharing Time Matters user questions
	How do I share documents securely with my clients?
	Document Sharing window
	Documents Selected area
	Select Recipients area
	Sharing Options area

	How long can I share files?
	What type of Time Matters documents can I share?
	What Time Matters security applies to sharing documents?
	How do I remove document access from clients I've already shared with?
	How do  I change the sharing options after they are initially set?
	What happens when a document expires?
	If I delete files from WatchDox online, will it delete them in Time Matters?
	If I update a shared file, is it automatically updated on the sharing portal?
	How do I get a shared file from a client back into Time Matters?
	When logging into WatchDox for the first time, what do I need to do?

	Document sharing client user questions
	How do I create a user account on the document sharing portal?
	How do I log in and log off of the document sharing portal?
	Log in to the portal:
	Log off of the portal:

	How do I restore access when my password is lost?
	How do I change my password on the document sharing portal?
	How do I view and edit my account info on the document sharing portal?
	How do I view documents on the document sharing portal?
	How do I download documents on the document sharing portal?
	How do I send a document using the document sharing portal?
	How do I search for a document on the document sharing portal?
	How do I mark a document as read or unread on the document sharing portal?
	How do I delete a document on the document sharing portal?


	Communications
	View your email
	Create and send email
	Send instant messages to other Time Matters users
	Create a Phone record

	Reports
	Print a standard report
	Export a record list as an Excel spreadsheet

	Time and billing
	Create a timesheet
	Set up basic billing
	Create an invoice
	Print a prebill
	Create a bill
	Post or undo a bill

	PCLaw link
	PCLaw link overview
	Before you install
	Back up your Time Matters database
	Back up your PCLaw database
	Set up the PCLaw Remote Client Server

	Set up the link in PCLaw
	Set up the link in Time Matters

	Set up the PCLaw billing link with Time Matters

	Time Entry Advisor
	Time Entry Advisor overview
	View records on the Time Entry Advisor
	View uncharged time
	View records awaiting billing
	View ignored records
	Other Time Entry Advisor tasks
	Filter the list of records shown on the Uncharged Time tab
	Change records on the Time Entry Advisor
	Send records to Microsoft Excel
	View uncharged time for a specific Matter or Contact
	Bill uncharged time discovered by the Time Entry Advisor



	Time Matters for Microsoft Office
	Overview of Time Matters for Microsoft Outlook
	Overview of the Time Matters pane in Outlook

	Install Time Matters for Microsoft Outlook
	Requirements
	How to enable Time Matters for Microsoft Outlook
	Enable the feature

	If the Time Matters pane does not appear in Outlook

	Log in to Time Matters for Microsoft Outlook
	View Contacts and Matters in Time Matters for Microsoft Outlook
	Outlook Contacts versus Time Matters Contacts
	View Contacts and Matters
	When the Time Matters pane is collapsed
	When the Time Matters pane is expanded


	Search for Contacts and Matters in Time Matters for Microsoft Outlook
	Enter time and expense using Time Matters for Microsoft Outlook


